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SoftGoods is a Vectorworks® Plug-In that enables you to insert Hybrid (2D and 3D) models of curved and
straight curtains and borders and straight pipe-and-drape runs.

Notable features:

• Models can be created from-scratch or based on pre-existing geometry (lines, arcs, polygons, and
straight polylines).

• Resizing curtains (including curved curtains’ radii) is as easy as dragging Control Points.
• Many aspects of the object geometry are adjustable on-the-fly, such as curtain heights, pleat

geometry, and curtain openings and tracks.
• Models of pipe-and-drape runs use stock and custom slider sizes, have various hardware visibility

settings, and allow users to track counts for hardware and drape sections.
• In addition to opaque single-color curtains, SoftGoods can create models with easily-mapped images

(with adjustable scale and positioning) and scrims.
• All model elements are automatically textured.
• Select text can be shown and various data can be tracked for WorkSheets and Reports.
• The different object parts can be automatically assigned to Classes.
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SoftGoods requires Vectorworks® and Renderworks® 2009 or newer.

License

By downloading and using this (or any) version of any of SoftGoods, you agree to the following:

1) You agree that you are using SoftGoods under a license granted by Landru Design.

2) You agree that all title, ownership, rights, intellectual property rights in and to SoftGoods and all copies
thereof, regardless of form (including, but not limited to, computer or source code and any related
documentation), are owned or expressly licensed by Landru Design.  Such rights extend to all updates of
SoftGoods and any related derivative works. 

3) You agree not sell, rent, lend, loan, lease or otherwise transfer or distribute the SoftGoods software.  
Furthermore, you agree not modify, dissemble, decompile, or reverse-engineer the SoftGoods software.

4) You agree that a download/license of SoftGoods is intended for a single, individual user.  Please contact
Landru Design for multi-user/site licensing.

5) You agree that this license may be terminated by Landru Design if you fail to comply with its terms and
conditions.  You agree that, upon such termination, you will destroy (or permanently erase) all copies of
SoftGoods.

6) You agree that SoftGoods is provided "as is" and is provided without warranty of any kind, either express,
implied, or statutory, including but not limited to, any implied warranties of merchantability or fitness for a
particular purpose.  You agree not to hold Landru Design or any of their owners, personnel, subsidiaries, or
affiliates responsible for any damages of any kind resulting from the use of this software, including but not
limited to, inaccuracies, loss of data, loss of goodwill, work stoppage, computer or software failure or
malfunction - and all other direct, indirect, incidental, special, exemplary or consequential damage and losses. 
In the event that Landru Design is found liable to you, you agree that such liability shall not exceed the
amount of fees paid by you for the use of SoftGoods
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Installation

SoftGoods consists of two files:
< SoftGoods.vso
< Convert to SoftGoods.vsm

Copy both files to the Plug-Ins folder of your Vectorworks® folder.

Vectorworks® should not be running during this installation process.

Next, add the tool and command to your favorite Workspace.  If you've never done that before and are not
near your Vectorworks® manual:

- Click...[Tools]...[Workspaces]...[Workspace Editor].  Make sure "Edit current workspace" is
selected and click "OK."

- In the resulting dialog, click the "Tools" tab.
- Scroll down the available tool section (the left side) until you see the "Landru" section. Click the

"+."
- Drag the SoftGoods icon to an existing palette or create a new palette (or Tool Set) and drag the

icons there.
- Click the "Menus" tab.
- Scroll down the available tool section (the left side) until you see the "Landru" section. Click the

"+."
- Drag “Convert to SoftGoods” into the desired menu position in the right-hand pane.
- Click "OK."
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Using SoftGoods

Starting with pre-existing geometry:
Select lines, polygons, arcs, and/or straight polylines.  Select the “Convert to SoftGoods” menu
item.  Arcs will be converted to curved curtains.  For other geometry, individual straight
SoftGoods segments will be created.  If an initial settings dialog appears, make any default
changes you wish and click “OK.”

Creating SoftGoods models from-scratch:
Select the SoftGoods icon from the tool palette to which you added it earlier.  Click in your
drawing where you want your SoftGoods object to start.  Click where you want your object to
finish.  If an initial settings dialog appears, make any default changes you wish and click “OK.”

With the newly-placed SoftGoods object(s) selected, make sure the Shape tab is in the forefront of the
Object Info palette to make adjustments. 

To resize SoftGoods objects, enable Vectorworks’® Interactive Scaling and move Softgoods’ Control Points
(the small blue squares that appear in the model).

To keep the interface clean, not all of SoftGoods’ parameters will be visible or available in the Object Info
palette at all times.  Some will be seen or enabled for only specific instances.

SoftGoods’ different parameter settings are detailed in the pages that follow...

Please forgive any discrepancies between this manual, its illustrations, and reality.  It is often easier
to make software fixes and/or additions than it is to keep a manual current.
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Function: Curtain or Border

Class, Layer, X, Y, Z, and Rotation:  Settings similar to other Vectorworks® symbols and objects.    (“Z” is the distance
from the drawing’s ground plane to the bottom of the Curtain or Border.)

Reference Width:  The distance between the endpoints of the SoftGoods instance.
Type: “Straight” or “Curved.”
Function: “Curtain,” “Border,” or “Pipe-and-Drape.”

Curtain: Draws softgoods elements centered on the reference geometry.
Border:  Draws softgoods elements offset relative to the reference geometry.  Offset side is changed using “Reverse

Side.”
Pipe-and-Drape:  Creates straight pipe-and-drape runs.  (The “Pipe-and-Drape” option is only included if “Type” is

“Straight.”  See pages 8-9 for info on “Pipe-and-Drape” settings.)
Show Centerline:  Draws the SoftGoods’ centerline or, if the “Border” “Function” is chosen, the reference line.
Add Track:  Draws a curtain track.  (Only available if the “Curtain” “Function” is chosen.)
Track Width:  The width of the curtain track.  (Only available “Add Track” is toggled on.)
Show Traveler Pull:  Draws a graphic showing which end of a track holds traveler pull lines - “None,” “Start” or “End.” 

(Only available “Add Track” is toggled on.)
Open From:  “None,” “Start,” “Center,” or “End.”  Creates an opening in the curtain.  (Only available if the “Curtain”

Function is chosen.)
Width:  The width of the opening.   (Only available if an “Open From” choice other than “None” is picked.)
Show Ghost Curtain:  Draws 2D ghost curtain geometry in the curtain opening.  (Only available if an “Open From” choice

other than “None” is picked.)
Reverse Side:  Switches the side of reference line on which the border is drawn.  (Only available if the “Border” Function is

chosen.)
Running Width:  The total width  - or linear dimension - of the softgoods.
Height:  The height of the softgoods, as measured from the insertion point.
Simple 2D and Simple 3D: Will create lines or flat surfaces instead of curtain curves.
Pleat Width and Pleat Depth: Settings for changing pleat geometry.
Flip Pleats: Swaps “positive” and “negative” portions of the curtain geometry.
Adjust Starting and Adjust Ending: Adjusts starting and ending points of borders.   (Only available if the “Border”

Function is chosen.)
Softgoods Options: “Opaque,” “Scrim,” or “Image.”

Opaque: Opaque softgoods.  Color is determined by the fill color assigned by Attributes Palette or Class graphics
definition.

Scrim: Semi-transparent softgoods.  Color is determined by the fill color assigned by Attributes Palette or Class
graphics definition.

Image: Maps the texture assigned to the SoftGoods object through the Render tab of the Plug-In Object’s Object Info
Palette.

Scale %:  The size of the image. 100% matches the image’s width to the curtain’s width.  (Only available if  “Image” from
“Softgoods Options” is chosen.)

Horizontal Shift: Sets the horizontal displacement of the screen image, as a percentage of the curtain’s width.  Negative
values move the image to the left; positive, to the right.    (Only available if  “Image” from “Softgoods Options” is
chosen.)

Vertical Shift: Sets the vertical displacement of the screen image, as a percentage of the curtain’s height. Negative values
move the image down; positive, up.    (Only available if  “Image” from “Softgoods Options” is chosen.)

Reverse Image: Mirrors the image mapped to the softgoods.  (Only available if “Image” from “Softgoods Options” is
chosen.)

Location:  A place for entering a note about the curtain location.
Material Color:  A place for entering a note about the curtain material color.  (This has no effect on the fill color of the 3D

model elements.)
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Curtain or Border parameters, continued...

Material Type:  A place for entering a note about the curtain material type.
Top Finish:  A selection of different finishes for the curtain’s top.
Spacing:  A place for entering tie, hook, or grommet spacing.  (Only available if an appropriate “Top Finish” is chosen.)
Bottom Finish:  A selection of different finishes for the curtain’s bottom.
Sides Finish:  A selection of different finishes for the curtain’s sides.
Fullness %:  A place for entering curtain fullness information.  (This has no effect on the construction of the 3D model

elements.)
Lining:  A place for entering curtain lining information.
Note:  A place for entering a miscellaneous note, such as a stock number.
Class SoftGoods Parts:  Toggle to place the different elements comprising SoftGoods model into different classes.
Class Set:  Allows you to choose from 5 different sets of Classes for assigning attributes by-Class, similar to other tools’

“Style” Classes.  (Only available if “Class SoftGoods Parts” is toggled on.) 
Text Options...:  A button to open the “Text Options” dialog.  This dialog will allow you to show or hide and change

attributes of SoftGoods text.  (See page 10 for more information on the “Text Options” dialog.)
Default Text Positions:  Returns text to default locations.  
Update:  Click this button to regenerate the SoftGoods object.  You might need to click this when toggling “Class SoftGoods

Parts” on and off if you’re using Class Attribute settings.
SoftGoods Build:  The build number of the SoftGoods Plug-In Object code.



  S o f t G o o d s  1 . 3   

  p a g e  8  o f  1 0   

Function: Pipe-and-Drape

Class, Layer, X, Y, Z, and Rotation:  Settings similar to other Vectorworks® symbols and objects.    (“Z” is the distance
from the drawing’s ground plane to the bottom of the Curtain or Border.)

Reference Width:  The distance between the endpoints of the SoftGoods instance.
Type: “Straight” or “Curved.”
Function: “Curtain,” “Border,” or “Pipe-and-Drape.”

Curtain: Draws softgoods elements centered on the reference geometry.
Border:  Draws softgoods elements offset relative to the reference geometry.

(See previous pages for more information on “Curtain” and “Border” settings.)
Pipe-and-Drape:  Creates straight pipe-and-drape runs.  (The “Pipe-and-Drape” option is only included if “Type” is

“Straight.”)
Show Centerline:  Draws the Pipe-and-Drape run’s centerline.
Draw Slider(s):  Draws the sliders.
Slider Options: Different standard slider lengths, including “Custom.”  If you choose one of the standard lengths, SoftGoods

will calculate counts and lengths based on the “Target Length” you enter and the reference line length.  If you choose
“Custom” SoftGoods will determine the over-all Pipe-and-Drape run length based on the “Target Length” and “Slider
Total” you enter.

Target Length: The ideal slider length you wish to set.  If you enter a dimension within the capabilities of the standard slider
you’ve chosen, SoftGoods will estimate the best length based on even divisions of the total Pipe-and-Drape run length  
If the dimension you enter is outside the bounds of the standard slider you choose, SoftGoods will correct your entry.  If
you choose the “Custom” “Slider Option” the value you enter here is fixed.

Actual Length:  The actual slider length, as calculated by SoftGoods.
Slider Total:  If you choose one of the standard sliders, SoftGoods calculates this value.  If you choose the “Custom” “Slider

Option,” this is where you enter the number of segments you desire in your Pipe-and-Drape run.
Running Width:  The total width  - or linear dimension - of the Pipe-and-Drape panels.  (Because this value takes into

account upright diameter, this will probably be different from the Reference Width.)
Base Plate Size:  A list of standard base plate sizes, including a standard boom base.
End Hardware: Options for drawing the end base plates and upright poles:  “Both,” “First,” and “Last,” or “None.”  (For

instances in which one or both of the ends of your Pipe-and-Drape run connects with another Pipe-and-Drape run.)
First Plate Shift and Last Plate Shift: Options for shifting the end base plates:  “None,” “In,” and “Out.”
Upright/Plate Total:  The calculated number of upright poles and base plates.
Hide 3D Uprights:  Hides the 3D upright poles so Pipe-and-Drape runs appear to be a solid run of curtain in renderings.  
Height:  The height of the softgoods, as measured from the insertion point.
Stock Drape Width:  The width of a stock individual drape panel.
Total Drape Count:  Taking into account the “Stock Drape Width,” the total number of drape panels needed for a given

Pipe-and-Drape run.  (For example, if your run has 3, 8' sliders and your stock panels are 5' wide, a total of 6 panels will
be needed.)

Simple 2D and Simple 3D: Will create lines or flat surfaces instead of curtain curves.  Will also hide the 3D portion(s) of the
slider(s).

Pleat Width and Pleat Depth: Settings for changing pleat geometry.
Flip Pleats: Swaps “positive” and “negative” portions of the curtain geometry.
Softgoods Options: “Opaque,” “Scrim,” or “Image.”

Opaque: Opaque softgoods.  Color is determined by the fill color assigned by Attributes Palette or Class graphics
definition.
Scrim: Semi-transparent softgoods.  Color is determined by the fill color assigned by Attributes Palette or Class

graphics definition.
Image: Maps the texture assigned to the SoftGoods object through the Render tab of the Plug-In Object’s Object Info

Palette.
Scale %:  The size of the image. 100% matches the image’s width to the curtain’s width.  If “Hide 3D Uprights” is toggled

on, this width is the whole width of the Pipe-and-Drape run.  If not, this is the width of an individual run segment. 
(Only available if  “Image” from “Softgoods Options” is chosen.)
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Pipe-and-Drape parameters, continued...

Horizontal Shift: Sets the horizontal displacement of the screen image, as a percentage of the curtain’s width.  Negative
values move the image to the left; positive, to the right.    (Only available if “Image” from “Softgoods Options” is
chosen.)

Vertical Shift: Sets the vertical displacement of the screen image, as a percentage of the curtain’s height. Negative values
move the image down; positive, up.    (Only available if “Image” from “Softgoods Options” is chosen.)

Reverse Image: Mirrors the image mapped to the softgoods.  (Only available if “Image” from “Softgoods Options” is
chosen.)

Location:  A place for entering a note about the curtain location.
Material Color:  A place for entering a note about the curtain material color.  (This has no effect on the fill color of the 3D

model elements.) color
Material Type:  A place for entering a note about the curtain material type.
Note:  A place for entering a miscellaneous note, such as a stock number.
Class SoftGoods Parts: Toggle to place the different elements comprising SoftGoods model into different classes.
Class Set:  Allows you to choose from 5 different sets of Classes for assigning attributes by-Class, similar to other tools’

“Style” Classes.  (Only available if “Class SoftGoods Parts” is toggled on.) 
Text Options...:  A button to open the “Text Options” dialog.  This dialog will allow you to show or hide and change

attributes of SoftGoods text.  (See page 10 for more information on the “Text Options” dialog.)
Default Text Positions:  Returns text to default locations.  
Update:  Click this button to regenerate the SoftGoods object.  You might need to click this when toggling “Class SoftGoods

Parts” on and off if you’re using Class Attribute settings.
SoftGoods Build:  The build number of the SoftGoods Plug-In Object code.
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Text Options dialog

Optional Elements to Show:
A list of potential text elements that can be shown as part of the SoftGoods model.  Only items appropriate for a given
SoftGoods function will be enabled.  For example, as seen here, the elements appropriate for Pipe-and-Drape runs can’t
be shown on Curtain or Border models.

Text Attributes (only enabled if at least one text element is selected to be shown):
Stack Text:  This will cause multiple text elements to be created as separate lines, as opposed to one, single line for all.
Stack Text:  If this item is checked, text will always be centered on the SoftGoods reference line and offset from the model

geometry.  Unchecking this box will display a Control Point for the text, allowing the text to be dragged to other
locations.

Keep Text Horizontal:  Toggle on to keep text horizontal, regardless of the SoftGoods rotation angle.
Size:  The size of the text element, in points.
Color:  A pop-up to let you pick the color of the text element using the Vectorworks® Color Picker.
Horizontal and Vertical Alignment:  Pop-ups to let you select text alignment and justification.


